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SCOTI LE Ad Hoc: Create Mailing Labels

In the Ohio Job Net (OJN) system, users were able to request mailing labels for job
seekers, for veteran job seekers and for employers. The request was sent to the OJN
support staff who sent aform to MIS. They actually ran the query to product the labels
and mailed the labels to the requestor.

The SCOTI system has a correspondence function that takes aletter text and adds an
inside address that is displayed in a window envelope. This function replaces the “run a
query and print the labels’” function of OIJN. However, the Correspondence function does
not yet have any controls on how many letters may be generated. Until this change is
accomplished, SCOTI users may obtain labels by accessing the SCOTI LE Ad Hoc
Reports. Go to the report menu and select the appropriate label query — Job Seeker,
Veteran, or Employer Labels.

3 Open Workbook from Database

Choose aworkbook to open:

RPTLE Active Seeker Mailing Labels

RPTLE Average Joh Motification & Referral Time{Office)
RPTLE Average Job Maotification & Referral Time(State)
RPTLE.Employer Mailing Labels

RPTLE.Seeker Availability

RPTLE.Seeker Mailing Lahels

RPTLE eteran Mailing Labels

RPTWIA.Case Manager (Central Office)

DTN T limwmt Clicikilibe S0 omteal Offieoss

[ *

—Description %

F.

[ Help ( J[r Cancel Jj

After making your selection, enter the required information (usually a county name)
and run the report.
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After the report runs, click on File > Export. Thiswill alow you to choose the type of
file and location of the exported file.

Export Wizard - Step 1 of 4: Select Dbjects

This wizard exports Discoverer data.

Which worksheets do you want to expart?

® Current worksheet

Al workshests

Wihat do you weant to export?

CrBoth Graph and Table ! Crosstab
® Table Crosstab only

O Graph only

T ( gack |_uExt ) ( Emsn | [ cancel

Follow the Export Wizard and click on Next. (Export Wizard — Step 1 of 4: Select
Objects)
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/3 Export Wizard - Step 2 of 4: Define File Details

What export format do you want for the Table / Crosstab?

1ru1i|:rnsnﬂ Excel Wiorkhook (* xls) 'l

Microsoft Excel Warkbaaok (*xls)
Microsoft Excel Warkbaok with PivotTable (& xls)
Hyper-Text Markup Language & htrm)

Text (Tab delimited) * td)

CEV (Comma delimited) (*.u:sv IElruwse
Formatted Text (Space delimited) *.prm ol =
! Ciracle Repors (xml
DIF (Data Interchange Format) (*.dif Wl

( Help ( Back ‘l Mext )( Einish (Cancel i

Click on the Down arrow and choose Text (Tab Delimited) (*.txt) as the format that the
file needs to be saved as. (Export Wizard — Step 2 of 4. Define File Details)

3 Export Wizard - Step 2 of 4: Define File Details

Wihat export format do you want for the Table § Crosstah?

| Test (Tab delirmited) (* td) x

Wihere do you want to ave the file?

iC:\WINDOWSLActi\re Seeker Mailing Labels bt IElruv_\tsQ..

-

( Help ( Back " Mt )( Einizh (Cancel

Select the location of where the file needs to be saved by clicking on the Browse button.
If satisfied with the location suggested continue to the next step. (Export Wizard — Step 2
of 4: Define File Details)
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a Export Wizard - Step 3 of 4: Edit Parameter ¥alues

Flease select values for the fallowing parameters for Active Seeker Mailing
Labels"

Enter County !'Lake' B

~Description

Mo description available

( Help ( Back || ________ M E}GILJ ( Eimish ( Cancel i
Click Next on the wizard (Export Wizard — Step 3 of 4. Edit Parameter Values)

a Export Wizard - Step 4 of 4: Supervise

Do you want to supervise the export process?

Touwill ba asked to resolve any issues
that accur during the export process.

T Unsupervised

Discovererwill autormatically run all queries before
worksheets are exported and will ignore all alert messages.

W Skip sheets with long running queries

—

( Help ( Back [ It (_Et;inish )( Cancel :I

Click Finish on the wizard (Export Wizard — Step 4 of 4: Supervise) Thiswill complete
the export of thefile.
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SCOTI LE Ad Hoc: Create Mailing Labels

; Export Log E2

Expott complete

Files exported to: CiMy Documents

Sheet Hame File:Mame Status

Active Seeker M... Active Seeker Mailing La... Sheet exported successfully

[ Opgen the first exported sheet

After successful exportation of the file an export log will pop up and say that the Sheet
exported successfully.

Open up Excdl.
Ed Microsoft Excel - Book1
& Fie | Edit Wiew Insert Format  Tools Data  Window  Help Type a question for help =) o @ %
,q|@ Gpen. . t@ Crl+0 | $ %, WREE _-BAL
» EALE R T T
id Page Sefup... End REvigw. ., o
& prit... Ctr+P
Create Adobe POF. .. F | P | H | | J | (i | 3
% 1 powerusermtg
o 2 Adimembership04
4 3 My Documentsiactive Seeker Mailing Labels
5
? 4 C:iMy Documentsiactive Seeker Mailing Labels
7 5 C\PRIVATE\Ohio_. ..\32 - Stacy Urch - 09-26-2004
g & Q\PRIVATE\Ohio_, |32 - Stacy Urch - 09-19-2004
g
_ﬁ 7 DimensionRolelUpdates
11 8 C\PRIVATELOhio_Works\OW_5...\SCOTI Utilization
£ 2 simplescoticcrbpriarity
13 ¥
|14
15
16
|17
15 | |
| 19 .
20 =
W 4 v miysSheetl  sheetz [ Shests / | «] i
Ready TLIR A

Open up the exported file that was created from Discoverer.
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2ix]

Open

'_
o
o
=
o

Ifﬁ My Diocuments j o (o * Tools =

Histany

w1 by Data Sources

by Fictures

Active Seeker Malling Labels
8| bctive Seeker Mailing Labels

o
1

2
O i
|3

i
)

[
=

My Docurments

il Shortcut (2] ta jinit
38 Shortcut to jinit
@ sqlnet.log

Diesktop slnet
@ hznames

B

Favarites

e

File marme: I _ﬂ open |'i
WL OIS s ot ype: | conedl |,

When the Open box appears make sure to select All Files from the Files of type: box at
the bottom of the wizard. The default option isto only show Exce files, not all files. If
thisis not selected properly the file that was saved (*.txt) will not be shown.

The next few screen shots show the Text Import Wizard steps and how to make sure that
the file is imported properly.

Text Import Wizard - Step 1 of 3 EJE3

The Text Wizard has determined that your daka is Delimited,
If this is correct, choose Mext, or choose the data tvpe that best describes vour data,

~Criginal data kyvpe
Choose the file type that best describes wour data:
i+ - Characters such as commas or tabs separate each field.
i F f - Fields are aligned in columns with spaces between each Field,

Start impork ak pow: |1 5‘ File origin: 437 1 OEM United States j

Preview of file C:\My DocumentsiActive Seeker Mailing Labels, Ext,

|1l PENNTS G SHER|&101 CEMTER ST| |MENTOR, OH 44050 ﬂ
|2 TVANEL EARNJIAK| 344664 TIRTE LANE| |EASTLAEE, O0OH 44035

|2 FREDERICKE E BATES|£5 ZAFFOIDD STREET| [MADISON, OH 44057

|4 PAUL B PROVOST|2274 MIDDLE RIDCGE PD| |PERRY, OH 44031

|E LOBPALTHNE C STEIMNER|33¢ & 2T CLAIL| |PAINESVILLE, OH 44077 ;i
| |

Cancel I =BGk I uext:|_\1 I Einish |

Click Next. (Step 1 of 3) Please make sure the Delimited box is checked.
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For Step 2 make sure that the Other box is checked and then insert the | in the box to the
right of the word Other. Thisis known as the Pipe and is selected by holding down the
shift key and the \ button (located directly above the Enter key) The following screens
show where these need to be placed.

Text Import Wizard - Step 2 of 3 EEd

This screen lets you set the delimiters your data contains, You can see
by wour ket is affected in the presiew below,

elimiters
v Tab [ Semicalon [ Comma

[ space l\T}cher: l_ Text qualifier: i "I

[ Treat consecutive delimiters as one

rData preview

CENNIZ = SHEA|E101 CENTED 2T| |[MENTOR, OH 440&0 ﬂ
MVANEL BADMJAK| 24664 IRIS LANE| |ERSTLAKE, OH 4403%

FREDERICE E EATEZ |62 SAFFORD STREET| |[MADISON, OH 44057
FAUL B PROVOST|2374 MIDDLE RIDGE RD| |PERDRY, OH 44021
LORDATNE C STEINER|226 & ST CLATR| |PATHESVILLE, OH 44077 -

K Jid
Cancel I < Back I Mext = I Einish |

Text Import Wizard - Step 2 of 3 EJE3

This screen lets wou set the delimiters wour data contains, You can see
by wiour bext is affected in the presiew below,

elimiters
v Tab [~ Semicolan I~ comma

[ Space W other: l|_ Text gualifier: i" "I

[ Treat consecutive delimiters as one

Data preview

CENNIS & SHEL K101 CENTEER BT MENTOR, OH 44080 ﬂ
MVANKL BADMIALE [FdE54 TEIS LANE EASTLAKE, OH 44035
FREDERICE E EATEZ K32 ZAFFORL STREET PADLIZ0N, OH 44087

FAUL B PROVOST 974 MIDDLE RIDGE RBD PERDRY, OH 44081
LORRPATNE C STEINER (23& & ST CLATLR PAINESVILLE, OH 440+

Fi i
Cancel I < Back I Mexk = I Einish |

Notice the Data preview has changed to show the different columns.
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Text Import Wizard - Step 2 of 3 EJE3

This screen lets wou set the delimiters wour data contains, You can see
by wiour bext is affected in the presiew below,

elimiters
v Tab [~ Semicolan I~ comma

[ Space W other: [”_ Text gualifier: i" "I

[ Treat consecutive delimiters as one

Data preview

CENNIS & SHEL K101 CENTEER BT MENTOR, OH 44080 ﬂ
MVANKL BADMIALE [FdE54 TEIS LANE EASTLAKE, OH 44035
FREDERICE E EATEZ K32 ZAFFORL STREET PADLIZ0N, OH 44087

FAUL B PROVOST 974 MIDDLE RIDGE RBD PERDRY, OH 44081
LORRPATNE C STEINER (23& & ST CLATLR PAINESVILLE, OH 44D_v_I

Fi i
Cancel I < Back l Mept, = I Einish |

Click the Next button (Step 2 of 3)

Text Import Wizard - Step 3 of 3 EEd
This screen lets wou select each column and set olumn data Format
the Data Format, f* erea

‘General converks numeric walues to numbers, date O Text
walues to dates,; and all remaining walues to text, © Date; MDY o

Advanced. .. |

" Do nat impart column (skip)

Data preview

sneral CencrlCeneral

=101 CENTEE ST MENTOR, OH 44080 ﬂ
74654 IRIS LANE EASTLAKE, OH 4403F%

59 SAFFORD STREET MADISON, OH 44087
974 MIDDLE RIDGE REI PERRY, OH 44081
36 5 ST CLAIER PAINESVILLE, OH 440+

Cancel I < Back I felEwet = i

This screen alows you to change the column format. Because we are just using General
data nothing needs to be altered. Click on Finish.
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EJd Microsoft Excel - Active Seeker Mailing Labels

@ File Edit Wiew | Insert IFgrmat Tools Data  Window  Help Type aquestion for help =S @ X
Arial | I}_UWS | S . 5. é ..
D=z = cane A 100 = (2)

o i T

Al - M .. HEA
2 Bl £ Function...

1 [DENNIS de101 Hame TOR, OH 44060

2 [VANKA E34664) TLAKE, OH 44095

| 3 |FREDERICEY 5o Eetue ISON, OH 44057

4 |PAUL R P 3974 z R¥, OH 44081

5 |LORRAINE336 S STCLAIR  PAINESVILLE, OH 44077

B |DAWVID A F 4765 WALDAMERE /WILLOUGHEY, OH 44094

7 |KELLY M 7225 SUMMER HILL PAINESWILLE, OH 44077

SUSAN M 33310 LAKESHORE |EASTLAKE, OH 44095

JOHN F 1 18 MEADOWLAWN |MENTOR, OH 44060

10 |ROBERT 6269 SEMINOLE TRAMENTOR, OH 44080

11 |JAMES A 10709 DORMAE CT | PAINESWILLE, OH 44077

| 12 [TRUDY 508703 MARJORY DRIWMENTOR, OH 44060

13 |STEPHEN 5129 ROBIN HOOD RWILLOUGHBY, OH 44094

| 14 |HELEN R 506 COURTLAND ST FAIRPORT HARBOR, OH 44077

15 [WILLIAM (1976 MARSH LANE PAINESYILLE, OH 44077

|16 |STEPHEN 30520 WILLOWICK DVWILLOWICK, OH 44095

|17 [DANIEL M 12901 HORIZONS DRLEROY, OH 44077

| 18 |JAMES E 38285 DODDS HILL CWILLOUGHEY HILLS, OH 44094

19 |HOWARD 37348 GROVE AVE 2WILLOUGHBY, OH 44094

20 LIFNMNIFERSR3T REEF RD Il THE LAKE. OH 44060 |
; 4] | :JJ_‘

>

e

G m
5
W
i
i
4
N
SRl
b
-+
=
el

.
)
.
i
I
.

LS

-

-

Ready UM

The address should be showing up on the Excel screen at this point. The next step isto
Insert arow so the Column headers can be added. Click on Insert > Rows, making sure
the cursor is gitting on the first namein the list (Cell Al).

Fd Microsoft Excel - Active Seeker Mailing Labels

@ File Edit “Yiew Insert Formab Tools Data Wwindow  Help Type & question for help = o @X

B % %, Wi EE  -5HA-
i Al 2 T

o -l o= - g] Bl 45 00 - (7))

-~ Arial =10 =B &£ O =
D=y 2% FBE-d
A tata AT B | e
Al - B Mame
& [ B [ © | D S| I | T ) [ ) | T ) |

1 [Mame Addy  Addy2  City
2 |DEMMIS GB101 CENTER ST MEMTOR, OI—F}fJDED
WANKA B 34664 IRIS LAMWE EASTLAKE, OH 44035
FREDERICES SAFFORD STREEMADISON, OH 44057
5 |PALL R P 39374 MIDDLE RIDGE PERRY, OH 440581
5 |LORRAINE3IIG 5 ST CLAIR PAINESWILLE, OH 44077
DAID A FA7ES WALDAMERE AWILLOUGHBY, OH 44034

8 |KELLY M 7225 SUMMER HILL PAINESWILLE, CH 34077

3 |SUSAN M 33310 LAKESHORE [EASTLAKE, OH 44095

10 [JOHM F M 18 MEADCWLAWEN MENTOR, OH 44060

11 |ROBERT (6269 SEMINOLE TRAMENTOR, OH 44060

12 [JAMES A 10703 DORMAE CT  PAINESWILLE, OH 44077

13 |TRUDY SC8703 MARJORY DRMMENTOR, OH 44060

14 |STEPHEN 5129 ROBIN HOOD RWILLOUGHBY, OH 44094
| 15 |HELEM R 1806 COURTLAND 5T FAIRPORT HARBOR, OH 44077
|16 [WWILLLAK (1976 MARSH LANE PAINESVILLE, OH 44077
|17 |STEPHEM 30520 WWILLOWYICK DWWILLOWACHK, OH 44095

18 |DAMIEL M 12901 HORIZONS DRLEROY, OH 44077

19 |JAMES E 38285 DODDS HILL CWWILLOUGHBY HILLS, CH 440594

-

4l

LIl

20 [HOWARD 37348 GROVE AVE SWILLOUGHBY . OH 44024 |
M 4 » M} Active Seeker Mailing Labels 4] | v
Ready HUM L

Insert the headers in cells A1 (Name), B1 (Addy), C1 (Addy2) and D1 (City).
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E3 Microsoft Excel - Active Seeker Mailing Labels

@ Eile I Edit Miew Insert Format Tools Data  Window  Help Type a question for help o B 0xE

W open.. cho | g9, W% EaE - A
T N ez iz e <0,
i d Rage S&tup. L% End Review.., o

&b Print... Cr+P

[ | create adobe POF... B W we e
% 1 C:iMy Documentstactive Seeker Mailing Labels o=
s 2 disadult 5
i 3 QUPRIYATE \Ohio_,, 132 - Stacy Urch - 09-26-2004

5 )

] 4 C\PRIVATE\Ohio_, . 132 - Stacy Urch - 09-18-2004 077

7 5 DimensionRoleUpdates HO94

[ & QUPRIVATE\Ohio_Works|OW S...\SCOTI Utilization 0s7

—1'90— 7 simplescoticcrbpriority £

:1_1: 3 CiMy DocumentstActive Seeker Mailing Labels

i 9 powerusermbg 077

13 ¥

14 [ETEFTENS 129 ROD HUU0 RO OGS T, on 44094

| 15 [HELEM R 506 COURTLAMD ST FAIRPORT HARBOR, OH 44077

16 | WWILLIAR (1976 MARSH LANE PAINESYILLE, OH 44077

|17 | STEPHEN 30520 WILLOWICK DWILLOWICK, OH 44035

| 18 |DANEL M 12501 HORIZOME DRELERCY, OH 44077

| 19 | JAMES E 382585 DODDS HILL OWILLOUGHBY HILLS, OH 44034

20 [ HOWWARD 37348 GROVE AVE SWILLOUGHEY . 0O 44034 =
M 4 r M} Active Seeker Mailing Labels 4] | »
Ready UM s
Save the document at this point. Select File > Save As.

Save As 7] ]

Save in |@ Iy Dacurments j - @ * E, + Tools =
- |1 History
t; i |25 My Data Sources
Histary: B ty Pictures

r% &ctive Secker Mailing Labels

Favarites

File name:

o

_ﬂ Save I
:{L Cancel |

Make sure to save the file in the appropriate folder. Also make sure to save the document
as aMicrosoft Excel Workbook, the default “ Save as Type’ is atext file. Thiswill allow
the document to be saved properly for merging into Word.

I.ﬂ.ctive Secker Mailing Labels

WWeb Foldars

4

Sawve as bype:

Microsoft Exeel Wark
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Open up Word.

i Document] - Microsoft Word
Edit Insert

&3 7 A Noma

; Final Showing Markup €|

- Fle Wigt Farmat:
» | Tir

v Show =

Tonls IT‘QH]E Window  Help

¥ speling and Grammar... F7

Language ]

=

[ Latters and Mailngs ]

o 5 B4 3 me

Ml Mege Wizard. .,

Tools on the Web. ..
AutoCorrect Options. .,

Options. ..

w
¥

A0
Show Mail Merge Toolbar
[=] Ervelopes and Labels...

Letter WWizard...

I [=]

Type a question For help =%

i A

»

[+

-
; =
mM O.

=

=@ 3 *

SDrawr [ Auteshepesv o w [ O [E] 4| 9 B P d-A - == B,

Page 1 Sec 1 11 at 1" ln1 Caoll REC TRE EXT OYE o

With a new document select Tools - Letters and Mailings > Mail Merge Wizard. This

will start the mail merge

@ & Mail Merge b

b4

Select document type

What tyvpe of document are you
working on?

) Letters
) E-mall messages
@ Envelopes

%:;abels
irectory

Labels

Print address labels for a group
mailing.

Click Mext ko continue,
Step 1 of 6

g Mext: Starting document

process.

The mail merge wizard will start on Step 1 of 6. Make sure to
select Labels. Then select Next: Starting document.
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4@ 4 Mail Merge * X

Select starting document

How dio wou wank to sek up your
mailing labels?

& lUse the current docurment
® Change document layout

0 Skart From existing document

Select Label Options to chose the appropriate style

Change document layout

Click. Label options ko choose a
label size.

E Label u:n;tin:nns. i

Select label size

Step 2 of 6

g Mext: Seleck recipients

41 Previous: Select document bype

Label Options EE2 |
Printer inforrmation

" Dot makrix

" | acer and ink jet Travy: |DeFauIt kray (AutoSelect Tray) j
Label infarmation

Label products: I.ﬂ.very standard j :

Product number: bl i

e ikt G HF] :J abel information

5066 - File Folder i Type: Address

E095 - Mame Badge Height: 1

5096 - Diskette _ .

5097 - Diskette Width: 2,63

5159 - Address Page size: Letter (3 WA x 11 im)

Details. .. Mew Label. .. FElEte I (0] 4 Zancel

L
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and size of label that will be used for printing.

Select the
appropriate L abel
product (most
commonly used is
Avery) and the
Product Number.

Then select OK.
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4@ 4 Mail Merge * X
st 3 Left Image:
Select starting documen cli .
ick Next:
How dio wou wank to set up your Select recipients
rmailing labels? P
i Use the current document to pl’OCSEd to the
i Change document layout next step.
0 Skart From existing docurment
Change document layout
Click. Label options to choose a
label size. .
Right Image:

[ Label options... Click on Browse

to use an existing
file. Thisis
where the file will
be chosen that
was just created

from Excel.
Step 2 of 6

g Mext: Seleck recigigﬁlﬁ;}

4@ Previous: Select doc peswt wizard <l

4@ & Mail Merge * X

Select recipients

) |lse an existing list
i Select from Sutlook contacts

i Type a new list

Use an existing list

IJse names and addresses from a
file or a database,

Browse, .,

il Edit{binipnr list..

- Select recipient lisk File

Step 3 of 6

g Mexk: Arrange your labels

4@ Previous: Sktarting docurment

Select Data Source 2 { %]
Lack in: Ifﬁ My Documents j oo @ SO * Todls ~
Histomn
Pt
o) by Data Sources
History  |— hy Pictures
My Diocuments
i# : j
Desktop
Favatites
__._j bl raiEs I j Mew Source, .. I pe
i
‘Web Folders Files of Lype: I,Cl." Dakta Sources -ﬂ Cancel |

Select the appropriate .xIs file and click Open. This will bring up a new window, making

sure that the correct table is selected from the file.
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Select Table EiE3
| Mame | Ciescripion | Maodified | Created | Ty¥p
‘Bitive Seeker Mailing Labels$' f29/04 8:10:07 AM 9/29/04 5:10:07 &M TAE

4 |
)

IV ‘First pow of data contains column headers Ok &I Cancel

Make sure the box “First row of data contains column headers’ is selected and click OK.

Mail Merge Recipients EiE3

To sork the lisk, click the appropriate column heading, To narrow down the recipients displayed by a
specitic criteria, such as by city, click the arrow pext to the column heading, Use the check boxes or
buttons to add or remove recipients From the mail merge.

List of recipients:

[ = N [= v = & [ = add ] R
i -
WANK. . | EASTL.. | 34EE4
FRED..  MADIS.. FE9CAF.

PAUL.. | PERR.. 3974
LORR..  PAINE. 3365..
D&VID_ WILLD  47E5
KELLY.. PAIME. 72255
SUSA. | EASTL.. | 33310 .
JOHN .. MEMT. | 18 ME..
ROBE..  MENT.. E2E95S..
JAMES.. PAIME.. | 10709 .
TRUD.. | MENT.. 8703
M STEP.  willO.  5129F e

Select All I Clear Al | Refresh I

Find... | EdiE, | Validate |

Make sure there the check boxes are clicked on the left side and select OK.
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@ Mail Merge * X

Select recipients

) Use an existing list
7 elect from Cutlook contacts

i Type a new list

Use an existing list

Currently, wour recipients are Left image: Sel eCt

;Z'Tted;mg L Next: Arrange your
CLve Seerer Maling Labels: in C | I IS

Select a different: list. ..

Edit recipient list. .. nght |mage: Click on
Address block.
Step 3o0f B

Previgus— - -rtim= === =g}
* Mext wizard step

Ingert Addrezz Block E1E3 |

Specify address elements

¥ Insert recipient's name in this Format:

Joshua

Joshwua Randall Jr.
Joshua Q. Randall Ir.
Mr. Josh Randall Ir.
Mr, Josh ©n, Randall Jr,
M, Joshua Randall Ir,

L 2]

v Insert COmpany narme
W Insert postal address:

" pever include the counteyfregion in the address
" fAlways include the countryfregion in the address
™ only include the countey/region if different than:

Preview

Mr. Joshua Randall Jr.
Blue Sky Airlines

1 Airpork Way

Kitty Hawk, MC 27700

matcE Figlds. .. I 0k I Zancel
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4 0 Mail Merge * M

Arrange your labels

If wou have not already done so,
lay ouk waur label using the First
label on the sheet,

Ta add recipient information to
wour label, click a location in the
First label, and then dick one of the
items below,

F‘] Address blﬂtrl?

m Gresting n Insert formatted ac

*| Electronic postage..,

I Postal bar code...

El More items. ..

‘ehen ywou have finished arranging
waur label, click Next. Then vou
can preview each recipient's label
and make any individual changes.

Replicate labels

‘ou can copy the layout of the Firsl

label ko the other labels on the

page be clicking the button below, :
w

Click on Match Fields to select
the layout of the label.
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Match Fields 2|

Mail Merge has special features For easily working with addresses. Please specify address
figld companents to simplify address insertion.

Required information -]
Last Mame | Mame ;]
First Marne [irot available) =]
Courtesy Title [frot available) =]
Company | Addy ‘;I Bl
Address 1 g -

ity [ City -

State [frot available) =]

Postal Code [irot available) =]

Spouse Firsk Mame |{n|:|l: available) ;l
Optional information

Middle Marne [irot available) =]

SLIFE (oot swmil=blat 1.Z

Ilze the drop-down lisks to choose the field From wour database that corresponds to the
address information Mail Merge expects (listed on the left.)

Inzert Address Block El |

Specify address elements

¥ Insert recipient's name in this format:

Joshua :]
e

Joshua Randall Ir.
Joshua Q. Randall Jr.
Mr. Jash Randall Ir.
Mr, Josh ¢, Randall Jr.

Mr. Joshua Randall Ir.

¥ Insert company name
V¥ Insert postal address:

" [ever include the country/region in the address
" Always include the countryfregion in the address
£ Only include the countryregion i different than:

Presview

Mr. Joshua Randall Jr.
Blue Sk Airlines

1 Airport Wway

Kitty Hawk, MC 27700
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Each columnin
the file
represents arow
on the address
label. Make sure
to change the
Last Nameto be
“Name’,
Company should
be“Addy”,
Address 1 should
be“Addy2” and
City should be
“City”. Then
click OK.

(0] 4 ’\C—l Cancel i
) Click OK to continue.
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: @ & Mail Merge o
4 & Mail Merge s ) P it AT R T v
| - ' Left Image: Click el

To add recipient information to
wour label, click a location in the
first label, and then click one of the
ikems below.

F‘] Address black. .

Update al Labels—
this will update all
records to be in the

appropriate layout
that was just

Fk] Address block. .,
D Greeting line. ..
2 = Electronic postage. ..

Il Postal bar code. ..

D Greeting line. ..

J + Electronic poskage, .,

selected. More items. ..

I Postal bar code...

More items. ..

When wou have finished arranging
wour label, click Mext, Then vou
can preview each recipient's label

d make individual ch .
wWhen vou have finished arranging S RN A RS A R

wour label, click Mext, Then vou
can preview each recipient’s label
and make any individual changes.,

Replicate labels

Right image: Click
on Next: Preview
your |abelsto view
the labels.

‘fou can copy the lavouk of the Firsl
label ko the other labels on the
page by clicking the button below,

| Update all labels I

Replicate labels

‘fou can copy the lavout of Ehe Firsl
label ko the other labels on the
page by clicking the button below.

Step 4 of B

g Mexk: Preview your lab

Step 4 of & 4p Previous: Select recipier pawt wiza)

PSS N P SR P I Y |
[ -

=j Drocument! - Microsolt Word

Dbl At Wew  [resrt Formst Toos o Tabe Windee  Hep Tupe & question o hedp
Sisn (A %L noma 4Lt 3 TvesMswRonan 2012 & B F O E';;;:E- EEEIR S A
Pl hanrg kg = Showr | €2 ) Dp e B (3e b B LT

i o e R R R R LR B
L gz R TRET ..2...&5.1..4...4.. i ..‘..H,...‘ T ||i ':'..MIIMHDE - m
— Ll ] =
Preview your labels
: Soena ol the nergad 1aoek are

P BEWHIE D SHER VAN BARETAE FREDERICE EESTES preveeed here, Toprevies

- 6L1 CENTER 21 Hédn BIELAME Gt BAEFORL 2T ancther lshel didcore of the

: MESTCOE, OE S0 EASTLAKE. OH A0 BLATI20E, OH M0 fcdsing:

- 1 .

: JRULRDRDWIST LOFSANE [ STEVER: [T AFCE Fecpent: 1 Fo0

E: W7 WIDILEFDHERTD 336 2 37 CLAF. 1761 WALLAMEFE AVE

: TEFEY, OH W1l DADIEEVILLE, NEL4I0T OUNGHEY, OE4HE "B Find & redpan:..

e 1 Malre changres

; FELLY INTHE STEAR MR AL TOE FMAMEE TR

2 7335 ETTRAES: FILL TROVE 333 LAKESHORE BLYT 13 WEATNWLAH Yo can b changs your reapent

; TRIVESWILLE, OH W07 EASTLAKE, (14001 WENTOR, THLA16 b

= | £1f Edit reciiant b

. PIOHERT JHEM JAMIES & WA TRV ECHARFIE, \hen viou havs Fnzhed

E: 245 EEMINTILE TRAIL 108 IR CT | ET3 BAFIDEY TRVE Iahels. didk Nt

3 MEHTTF, DH 840 BATHEEITLLY, DEFSATT MENTOR, THAA6 ?E"W'fc:.l";m H':rmf\ged

= 1] lshel= or edit indadusl label ko

; TR HEH M GILEERT EELEN R RIOWAH 'RILLLA ) BUTTERMIEE aid persansl commers,

i SLIF RORIN HOOD R A0¢ COURTLAMD 5T | 1878 BLATS H LA

4 TWILLODGHREY, OH 84ms ATV OFT HAEEOR, OH4&-ET? 1 PJ.'DI'I'.'."J'II.L'I'? OHS4DT B ot 5:‘5

H dAepaods 000000000 0 00
i | | £

e STER FEH CAFFELDORR CUAMIT. B TICHL AOE TARKT K BIICHAL S0 @ L N!&Mﬂ“—!_"‘lﬂt?

o F0310 WILLOWIEK DR 13301 HEEIEOHS T | B33 DODS HILL O % i
Z TILL IO, CELAERT LEPOY. OH H0TT WTLLOUTHE'Y FILLE. 0 00 ¥ A Pravioue Arrangs Yo b bk iz
L 1EEE | v

e lr radchapesr s R IO E Al 0E @A -SFE0m

Pagg ] “5a L 11 L {1y RN o - Y -l T oy (T P | 4

The labels should appear on the left hand side of the screen. Click on Next: Complete the
Merge to finish the merge.
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4 % Mail Merge r X

Complete the merge

Mail Merge is ready ko produce
waour mailing labels,

To personalize vour labels, click
"Edit Individual Labels." This wil
open a nevs document with your
merged labels, Ta make changes to
all the labels, switch back ko the

ariginal document, L eft im@e:
Merge click on Edit [ = <]
Bz Print..., individual Merge records
% Edit individual labels. .. labels‘ ThIS
will merge the

Merge tonewdocum  |abels into a € Currgnt record

new " From! I To! I
document. oK I Cancel I

L=
Right image: Make sure al is selected to then click OK.

Step b of 6

48 Previous: Preview vour labels

Save As | 7] E
Save in I-ﬁ My Documents j oo € X O * Tools ~
- ] Hiztory
= |5 My Data Sources
.l y Pictures

| e
|3
It

My Docurments

B

=2
(a1}
un
=
m]
-

[

Favarites

lo

File mame: I.ﬁ.ddress Labels| | Save

Web Falders  s.uc as bype: [werd Document =] Cancel |

Save the final document in adesired location as a Word document. The labels can be
printed at any time.
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Some users have had issues with their laser printers heating up on long runs and softening
the label glue. Exactly how you cregte the labels from the SCOTI file will depend upon
your equipment and your staff preferences. If you experience difficulties in creating
labels from SCOTI Ad Hoc reports, please call the SCOTI Help Desk at 1-888-385-2588.

As soon as the limits on Corresponderce are created and tested, we will transmit
instructions on how to use that function to create a set of |etters for either local or central
printing and distribution. Until then, please use the SCOTI LE Ad Hoc method described
above.
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